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Chapter 1

Introduction
Welcome to the Using WorldServer and Studio Integration Guide. This guide provides

translators and project managers with information on the workflow between SDL

WorldServer™ projects and translation kits for SDL Trados Studio 2015. See the

Information Overview and Audience topics for more details on the structure of this guide.

Information Overview
SDLWorldServer can create a special WorldServer project package for SDL Trados

Studio 2015. While similar in concept to a project package created in Studio, the

WorldServer project package differs in its internal structure, and its filename has a different

file extension, .WSXZ.

As a project manager assigned to work on a WorldServer project, you may be responsible

for creatingWorldServer project packages as described in “WorldServer Project Package

Creation” on page 3. You might also be responsible for processing and importing results

packages, as described in “Returning Completed Work to WorldServer” on page 19.

As a translator or reviewer, you obtain and open a WorldServer project package as

described in “WorldServer Project Packages and Studio ” on page 11. You translate or

review the files in that package as you would any project in SDL Trados Studio 2015. On

finishing your work, you create a return package and upload it to WorldServer, or you

return the package to whomever is responsible for importing it. The WorldServer return

package also has the file extension .wsxz.

Note: Obsolete Studio SP1 kit incompatible with subsequent releases. SDL Trados

Studio 2014 users who installed the WorldServerTradosStudioFileType. msi

translation kit on their systems (to use Studio 2014 SP1 with SDLWorldServer 9.2) should

uninstall it. All the capabilities provided by the kit have been built in to subsequent

WorldServer and Studio releases.
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Audience
This manual is for people who are involved with projects that use SDL Trados Studio

2015 in conjunction with SDLWorldServer, and perform two different types of roles:

translators and reviewers, and project managers.

■ Translators and reviewers open and work with WorldServer project packages,

and then return the results back to WorldServer.

■ Project managers create and distribute WorldServer project packages. They can

also process and manually import results packages into WorldServer.

Note: These tasks may be performed by the same person.

This manual assumes that the reader is familiar with SDL Trados Studio 2015. For more

information, see the Studio Online Help .

Introduction
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Chapter 2

WorldServer Project Package
Creation

Depending on the procedures followed by your employer or business partner who uses

SDL WorldServer, project managers may be able to access that WorldServer system to

create and distribute a project package created by SDLWorldServer.

WorldServer Project Workflows
In SDLWorldServer, most work is performed within aWorldServer Project that represents

work associated with a translation effort for a single target locale. The WorldServer

project consists of one or more tasks running through a specific WorldServer workflow.

Each task represents a single file (known in WorldServer as an “asset”) that the workflow

processes.

In its simplest form, a WorldServer workflow consists of an ordered set of automated and

manual (that is, “human”) steps. Here is an example:

This workflow contains two automated steps (“Clear Segment” and “Segment Asset”)
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that prepare the file for translation. It also contains two human steps, “Translate” and

“Review.” Most production WorldServer workflows contain many automated and human

steps that may include quote preparation, pre-translation work, translation, review,

quality assurance, file delivery, etc.

In the workflow definition, the workflow designer assigns each human step to one or

more registered WorldServer users. During task processing, when WorldServer reaches a

human step it notifies all assignees by sending each of them an email message that

contains a link to the WorldServer task. To work on an assigned task, an assignee can

click the link in this email message, log into WorldServer, and then create and download

aWorldServer project package to use in Studio. Or, the assignee might send aWorldServer

project package to a colleague or business partner as an attachment to an email message

or via an FTP server. Once someone edits/translates online or exports the package, the task

is automatically claimed by that user in WorldServer, so that no one else can alter it.

Claiming is also important, as it is required in order to return the package and/or to make

live TM updates, when that option is enabled. When the assignment is complete, the

assignee creates a WorldServer return package, uploads it back on WorldServer from

Studio or sends it to the project manager to manually import it into WorldServer and then

move the task to the next step in the workflow.

Most WorldServer workflows include both a “Translate” step and a “Review” step. When

theWorldServer user assigned to the “Translate” step completes that step inWorldServer,

the workflow reaches the “Review” step, which it assigns to WorldServer users who are

identified as reviewers for the target language of the project. As did the translator, a

reviewer obtains a WorldServer project package to open in Studio.

About the Project Package
WorldServer project packages have a file extension of .wsxz and contain the information

needed in order to translate — or review translations of — files whose translation is

managed by WorldServer. Project information and associated metadata can be viewed in

SDL Trados Studio in the Project Attributes tab in the Projects view. With Studio 2015,

you can see real-time updates to the project in WorldServer as you work through it in

Studio. Each update to a segment or translation memory will be immediately reflected on

the WorldServer side, providing you have the necessary authorizations for WorldServer.

If not, the project manager gathers the information and brings it back into WorldServer.

Note: The following restrictions apply to the real-time updates:

■ WorldServer must be in Live TM mode

■ The Update checkbox must be selected in Studio in the Options dialog box

under Translation Memory and Automated Translation for the TM you are

using

■ Changes to source segments are not supported

■ Split and merged segments will not be updated. However, these split/merges will

be handled accordingly after re-importing the full package.

■ Any changes to tags will not be updated

WorldServer Project Package Creation
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■ Offline mode is not supported

■ Segments that were originally locked will not be updated.

With this release, the WorldServer package has been configured to be backward

compatible (that is, to work with versions of Studio prior to 2015). To make the package

backward compatible, you must select this option when exporting it.

The export package contains:

■ A segmented representation of each source file

■ The server-based TM assigned to the WorldServer project

This offers real-time access to the version of the TM available on the WorldServer

system. The WorldServer TM is enabled by default in the list of translation

memories applied to the project and it can be updated while confirming the

translations in Studio. This TM is only available for WorldServer packages opened

in Studio 2015 and only for Studio users with the required WorldServer

credentials

■ The file-based TMs assigned to the WorldServer project

These are the offline version of the TMs assigned to the WorldServer project, as

they were available when the WorldServer project was created. Studio users who

do not have access to the server-based TM can use these TMs when translating the

files in the WorldServer package. The changes to these TMs can be updated by

the WorldServer project manager when importing the return package into

WorldServer

■ WorldServer terminology entries

WorldServer includes a single project TBX file that contains relevant TD entries,

if they exist. When you open the WorldServer project package in Studio, this TBX

file is imported into a new Studio termbase file named WorldServer. sdltb

and is automatically included in the Studio project. The TD Name field in the

imported TD in Studio is displayed in the Term Recognition window by default.

When it is present, the termbase file includes information on individual terms:

■ Term statuses such as Proposed, Approved, Preferred, Deprecated and

Rejected

■ Task attributes and metadata information is exported for use by the Project

Manager

■ System attributes such as Created On, Created By, Modified On and

Modified By

■ Term and entry custom attributes, which are mapped to Studio attributes

■ Task information and associated metadata for each file in the package. Task

information can be viewed in SDL Trados Studio in the Files Attributes tab in

the Files view.

■ The Studio QAChecker Profile settings

WorldServer packages include the QAChecker Profile configuration defined in

WorldServer, so that Studio can automatically apply the same configurations to all

the files included in the package. Studio QA Checker analyzes Segments,

WorldServer Project Package Creation
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Segments to Exclude, Inconsistencies, Punctuation, Numbers, Word List, Regular

Expressions, Trademarks and Lengths. Applying the same settings ensures the

same translation quality across all the files in a WorldServer project, even if the

project files are split in multiple packages and sent to different Studio users.

To use a Studio QAChecker profile in WorldServer, first you need to upload it

from the location where SDL Trados Studio exported it. To do so, go to

Management > Administration > Customization, choose Studio QAChecker

Profile from the Custom component type list and then click Add. In the Add

Custom Studio QAChecker Profile Component dialog box, type a meaningful

name for your Studio QA Checker profile and then click Browse. Use the

Choose file to Upload dialog box to navigate your local directory structure, select

the Studio QAChecker profile and then click Open.

■ The TM Penalties defined in WorldServer for a TM or a group of TMs. Knowing

the penalty score that the WorldServer project manager defined for each TM

ensures that Studio users know the real value of each translation unit in a

WorldServer TM and can better assess their reliability. The TMs in a WorldServer

TM Group are listed individually in Studio and ordered by the priority set in

WorldServer.

■ The TMAttribute mismatch Penalties are applied in Studio the same way as

they are applied in WorldServer when the mapped metadata of the TM match does

not match the mapped metadata of the asset being translated.

Note: The File Type Support (FTS) server cannot specify segments to be excluded for

the .WSXZ export format.

Options for Creating the Project Package
Use your Web browser to log into the WorldServer system which has projects assigned to

you.

Note: The owner of the WorldServer installation must establish a user account for you,

and provide you with the Web address (URL) of the WorldServer system and your

Username and Password credentials.

When you point your browser to the WorldServer URL and enter your login credentials,

WorldServer displays its Home Page.

Amessage on the WorldServer Home Page displays the number of projects and tasks

currently assigned to you.

WorldServer Project Package Creation
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To see your assignments, select the number of assigned projects in this message.

WorldServer displays the Projects page that shows each of your assigned projects.

The Projects Page—Selecting a Single Project

About this task

To work on only one of your projects:

Procedure

1. Select one of your assigned projects.

2. In the WorldServer toolbar, click Translate...

WorldServer displays the Create Translation Kit for Projects window. For each file

in the project, WorldServer:

■ Claims the associated task for you, to prevent other users from working on the

same file

■ Locks the target file, again to prevent conflicting updates

■ Formats the source file for translation

■ Finds WorldServer translation memory and WorldServer terminology matches

for the file

WorldServer then gathers all of this information into a project package and downloads

that package file through your browser. The filename conforms to this format:

tasks_projectname_project#_target-locale_xliff.wsxz.

3. Save this file to a known location on your PC. (Do not select the default operation,

which is to open the project package directly in Studio.)

Note: You can also create a project package by selecting a single project and clicking

Export, as described in the Selecting Multiple Projects topic. This results in a single

archive file named xliff_projects. zip.

WorldServer Project Package Creation

7WorldServer and Studio Integration Guide



The Projects Page—Selecting Multiple Projects

About this task

To work on two or more of your projects:

Procedure

1. Select any of your assigned projects, and then click Export. WorldServer displays the

Create Translation Kit for Projects window.

2. Accept the default format, WSXZ, and click OK. For each file in every selected

project, WorldServer

■ Claims the associated task for you, to prevent other users from working on the

same file

■ Locks the target file, again to prevent conflicting updates

■ Formats the source file for translation

■ Finds WorldServer translation memory and WorldServer terminology matches

for the file

WorldServer then gathers all of this information for each project into a project package

file and then gathers all of the project package files into a single archive file named

xliff_projects. zip.WorldServer then downloads that zip file through your

browser.

3. Save this file to a known location on your PC.

The Task List Page—Selecting Tasks within a
Project

About this task

Instead of selecting one or more WorldServer projects, you may want to package some or

all of the individual tasks within a WorldServer project. Each task is associated with a

single file in the WorldServer project. To select individual tasks:

Procedure

1. In your Web browser, log into WorldServer.

2. Click the Assignments tab. Then click Projects.

WorldServer displays the Projects page that lists projects assigned to you.

3. Click the name of the Project whose tasks you want to see.

WorldServer displays the Task List for Project page for the selected project.

4. Select one or more tasks. To select all of the tasks in the project, click the checkbox in

the header bar of the task list.

5. Position your mouse over the expansion triangle at the right side of the Edit/Translate

button.

WorldServer displays a menu of supported editors.

WorldServer Project Package Creation
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6. Click In SDLTrados Studio...

WorldServer displays the Create Translation Kit for Projects window. For each

selected task, WorldServer:

■ Claims the task for you, to prevent other users from working on the same file

■ Locks the target file, again to prevent conflicting updates

■ Formats the source file for translation

■ Finds WorldServer translation memory and WorldServer terminology matches

for the file

WorldServer then gathers all of this information into a project package and downloads

that package file through your browser. The filename conforms to this format:

tasks_projectname_project#_target-locale_xliff.wsxz.

7. Save this file to a known location on your PC. (Do not select the default operation,

which is to open the project package directly in Studio.)

The WorldServer Task Assignment Email Message

About this task

If you have a user account on a WorldServer system in which you are assigned a task,

WorldServer notifies you of that assignment by sending an email message. The message

begins, “You have just been assigned task(s) for project(s) listed

below...” It contains a link to the WorldServer page that lists the assigned task(s) for
each project assigned to you.

If you receive a WorldServer task-assignment message, you can create a WorldServer

project package for an assignment:

Procedure

1. In the email message, click the link to a WorldServer assignment.

WorldServer displays its Login page.

2. Enter your login credentials, and click Login.

WorldServer displays the Task List for Project page for the assigned project.

3. Select one or more tasks. To select all of the tasks in the project, click the checkbox in

the header bar of the task list.

4. Position your mouse over the expansion triangle at the right side of the Edit/Translate

button.

WorldServer displays a menu of supported editors.

5. Click In SDLTrados Studio...

WorldServer displays the Create Translation Kit for Projects window. For each

selected task, WorldServer

■ Claims the task for you, to prevent other users from working on the same file

■ Locks the target file, again to prevent conflicting updates

WorldServer Project Package Creation
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■ Formats the source file for translation

■ Finds WorldServer translation memory and WorldServer terminology matches

for the file

WorldServer then gathers all of this information into a project package and downloads

that package file through your browser. The filename conforms to this format:

tasks_projectname_project#_target-locale_xliff.wsxz.

6. Save this file to a known location on your PC. (Do not select the default operation,

which is to open the project package directly in Studio.)

WorldServer Project Package Creation
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Chapter 3

WorldServer Project Packages and
Studio

Translators and reviewers may receive a WorldServer project package as an attachment to

an email message, or might download the project package from an FTP server. Opening

the WorldServer Project Package in SDLTrados Studio 2015 creates a new Studio project.

Note: SDL recommends that you only open WorldServer project packages with Studio

2015. While it is possible to open a WorldServer project package file directly from your

web browser's download dialog box or by double-clicking it in Windows Explorer, doing

so may have unexpected results.

Project Package Formats
You can receive WorldServer project packages in two different formats, one of which

requires an extraction step.

■ A file named xliff_projects. zip that can contain one or more project

packages. In this case, you extract the project packages files (which have a file

extension of .wsxz) from the .zip file and save them to a known location on

your PC. You open and work with a single project package at a time.

■ A file with the format tasks_projectname_project#_target-locale_
xliff.wsxz which contains a single project package. You open this file directly
in Studio.

Opening the Package

About this task

Use the following procedure to open a WorldServer project package:
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Procedure

1. Make sure you know the location of the WorldServer project package file (which has

a file extension of .wsxz) on your PC.

2. Start Studio, and then select File > Open > Package..., or click the Open

Package button in the standard toolbar).

3. Navigate to the WorldServer project package file, and select it.

4. Click Open.

The Converting WorldServer Settings page is displayed. On this page, you can

choose to Generate translation and analysis statistics to perform the Analyze Files

task and get the Analyze Files report for the files included in the package.

5. Click Next.

6. Choose an empty folder in the Project Folder field and click Finish.

7. When the package import preparation is complete, click Close.

8. You are now ready to work on the project files in SDL Trados Studio 2015. To enable

real-time updates between Studio and WorldServer, go to the Options dialog box,

select Translation Memory and Automated Translation and check Update next to

the TM that you are using to translate this package. This can be configured if

WorldServer is in Live TM mode.

Results

Studio imports the contents of the WorldServer project package and displays it in the

Projects view.

For projects created in WorldServer with the url_of_origin property configured,

Studio shows the WorldServer location of the project in the Server column of the Projects

view.

Note: Studio truncates WorldServer project or filenames longer than 50 characters.

Even with this change, Studio cannot open WorldServer packages if the temporary folder

path or the project names exceed 260 characters. To avoid exceeding this limit, change

your temp and tmp folders to a top-level folder, such as C:\TMP.

WorldServer Project Packages and Studio
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Translation and Review for WorldServer
Projects

After you import a WorldServer project package, you can translate or review the files in

that package as you would the files in any SDL Trados Studio 2015 project package. If

WorldServer found any translation memory matches for segments in the project files, it

includes in the WorldServer project package a TMX file that Studio imports into a project

translation memory (TM) whose name is WorldServer.

Behavior Differences
When you work with files in a WorldServer project package, you need to recognize some

differences in behavior between SDLWorldServer and SDL Trados Studio, including

the following:

■ Segment Comments

■ Segment Status

■ Segment Locking

■ Word Counts and TM Leverage

■ Inline Tags

■ Preview Capabilities

■ Due Dates

Segment Comments

SDL Trados Studio SDL WorldServer

Comment Scope File, segment, and range

comments

Note:When you select text

within a segment and then

create a comment whose

scope is Current
Selection, Studio
identifies this as a range

comment.

Segment comments.

WorldServer converts range

comments to segment

comments, and ignores file

comments

Comment Severity Comment Severity Level [Not available]

Comment Grouping Comments stored

individually and tagged

with user, date and time

All comments for segment

saved in one text block.

Each is preceded with a

separator that contains user,

date and time

WorldServer Project Packages and Studio
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Segment Status

SDL Trados Studio and SDLWorldServer use different values to identify translation

segment status. When you open a WorldServer project package or create a WorldServer

return package, segment status values are converted as follows:

When you export a translation kit (WorldServer project package) fromWorldServer

SDL WorldServer SDL Trados Studio

No Status (empty target) Not Translated

No Status (non-empty target) Draft

Pending Review Translated

Reviewed Translation Approved

Rejected Translation Rejected

When you import a translation kit (WorldServer return package) from Studio

SDL Trados Studio SDL WorldServer

Not Translated No Status

Draft No Status

Translated Pending Review

Translation Approved Reviewed

Translation Rejected Rejected

Sign-off Rejected Rejected

Signed Off Reviewed

Note:When the real-time segment update is enabled and you confirm a segment :

■ The segment status in WorldServer is set to Pending Review if the Studio editor is

open for translation (since the segment status in Studio is set to Translated when

it's confirmed)

■ The segment status in WorldServer is set to Reviewed if the Studio editor is open

for review (since the segment status in Studio is set to Translation Approved

when it's confirmed)

WorldServer Project Packages and Studio
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Segment Locking

In WorldServer, a workflow step may lock target segments whose translations it retrieves

from TM. WorldServer supports two types of segment locks:

■ Dynamic locks allow you to unlock and modify segments

■ Static locks do not allow you to modify segments

SDL Trados Studio does not distinguish between these lock types.

When you edit a file with locked segments in the Studio side-by-side editor, you will see

a lock icon in these segments. While Studio allows you to unlock and modify a locked

segment, WorldServer will not accept any changes to the contents of segments that it

locked with static locks. If you attempt to modify a static-locked segment, the Editor

displays a warning message.

However, depending upon your WorldServer user privileges, you may be able to add or

edit comments associated with static-locked segments. To do so, unlock the segment and

add or edit the comment. When you confirm that segment, if the lock is a static one, you

will have one of two options:

Commenting allowed on locked segments

The Editor displays a warning message to inform you that WorldServer will accept

changes to the comments, but not to the segment translation

Commenting prevented on locked segments

The Editor displays a warning message to inform you that WorldServer will not

accept either your comment changes or any segment translation changes

A similar issue occurs in the Editor if you modify and then lock a segment that is not

locked in WorldServer. When you confirm the segment, the Editor displays a warning

message to warn you that WorldServer will not honor this segment lock.

Word Counts and TM Leverage

You may find differences in word counts and translation memory match scores (leverage)

between SDL Trados Studio and SDLWorldServer, since they currently use slightly

different approaches to segmentation and leverage. The differences should not be

significant.

SDL Trados Studio will correctly display fuzzy match percentages after opening a

translation kit from WorldServer.

WorldServer Project Packages and Studio
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Inline Tags

SDLWorldServer and SDL Trados Studio both show nontranslatable markup within

segments as numbers enclosed within braces, such as {1}. WorldServer does not
distinguish among different types of these inline tags; it refers to all of them as
“placeholders.”

In each segment, placeholders in the target must match placeholders in the source. You

can move placeholders within a segment, but must not add or delete them. If placeholders

are missing, or there are more placeholders in the target segment than in the source

segment, you cannot create a WorldServer return package.

Tip: It may make sense in some cases to move a placeholder, for example, if the sentence

structure of the source language differs from that of the target language. However,

sometimes moving a placeholder can make the file invalid. For example, if you are

working with an HTML or XML file and you swap the order of an opening tag and a

closing tag, the file no longer contains valid HTML or XML.

Preview Capabilities

The preview feature of SDL Trados Studio (View > Preview) displays assets

contained in SDLWorldServer packages that have text, HTML, and XML formats. The

preview is available for the original file format associated with the following MIME types:

■ Text

■ text/plain

■ text/x-java-properties

■ application/x-javascript

■ HTML

■ text/HTML

■ application/x-jsp

■ text/x-asp

■ XML

■ text/xml

■ text/xsl

■ txt/x-idiom-dcr+xml

Project Package Due Dates

The task step due dates in SDLWorldServer are used for SDL Trados Studio project

packages, but only when the due date for each task in the project is the same. Otherwise

the due date in Studio is set to null.

WorldServer Project Packages and Studio
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Note: If the task step due date is specified without time, for example 1/23/10 instead of

1/23/10 03:30 PM, the time is automatically set to 5:00 pm.

Creating the Translation Return Package
When you are ready to return the results of your work to the WorldServer system on

which the project was created, you begin by creating a WorldServer return package in

SDL Trados Studio 2015.

About this task

Follow these steps:

Procedure

1. Be sure to save the files in your project.

2. Select Project > Create Return Package.

3. Select the files to include in the return package, and click Next >.

4. Specify a return package location, which could be the default URL of WorldServer or

a File. Studio adds the file extension .wsxz to indicate that this is a WorldServer

return package.

Note: An entry in the Comments field is used only if you later create a draft email

message when creation of the WorldServer return package finishes. WorldServer does

not use or retain the comments.

5. Click Finish.

Studio creates the WorldServer return package and displays its Create Return

Package dialog box.

6. To display any errors, click Show Results.

7. You can open the folder in which you saved the WorldServer return package and

create a draft email message with the WorldServer return package attached, or simply

click Finish to close the dialog box.

WorldServer Project Packages and Studio
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Chapter 4

Returning Completed Work to
WorldServer

Automatically Uploading the Return
Package from Studio

About this task

Follow these steps to automatically upload WorldServer return packages to WorldServer.

Procedure

1. Select Project > Create Return Package from the menu bar. The

Create Return Package wizard is displayed on the Select Files page. All files in the

project are included in the list, apart from reference files.

Note: If you select files that were not originally received in a project package, the

Create Return Package option will be disabled (grayed out).

2. Select or clear the check boxes next to the file names on the Select Files page to

include or exclude them from the package. If you have previously included any of the

files displayed in another return package, those files will not be selected by default.

3. Click Next.

4. Choose Server or File on the Return Package Options page.

Note: If the package was created in WorldServer and the url_of_origin setting
was configured by the Worldserver administrator, Studio automatically recognizes the
server where the package came from. The Server field shows the server of origin so

that you can upload the return package back to its original location onWorldServer. For

packages created in earlier versions, or for which the url_of_origin setting was

not configured, manually enter the server address in the Server field.

5. Click Authentication to enter your credentials for the specified server address.

6. If you want to add a comment to the return package, enter it in the Comment box.
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7. Click Finish to create the package and go to the Creating Return Package page.

Studio creates the return package and uploads it to WorldServer. Once the package

creation is complete, the statuses next to the progress bars change to “Completed.”

After the return package is created, the manual task assigned to the files in that package

is displayed as complete in the My Tasks folder on the navigation tree of the Files

view.

8. To complete the assigned workflow tasks whose files you imported, select the tasks

and click Complete.

WorldServer displays the Complete Task(s) page and moves the tasks to the next

step in their workflow.

9. The Next Step field lists each available path in the workflow. Select the appropriate

next step, enter a comment for the next person assigned a workflow step in this task,

and click OK.

If you are assigned the next human step in the workflow, the tasks remain on this

Task List for Project page, and the step name changes to identify the new step.

Otherwise, WorldServer removes the tasks from this page because they are no longer

available to you.

Manually Importing the Return Package
from WorldServer

If you are a project manager and you received a return package from a translator who

does not have the access to automatically upload the return package from Studio, you can

log into WorldServer and manually import the return package. You can also specify

now if you want to update the WorldServer translation memory with the changes that the

translator made in Studio.

About this task

Follow these steps to import WorldServer return packages into SDLWorldServer.

Procedure

1. Log into the WorldServer system on which the project was created. You can enter the

URL of this system directly in your Web browser, or you can click the link in a

WorldServer task assignment email message that you received.

2. Enter your login credentials, and click Login.

If you clicked the link in a WorldServer task assignment email message, WorldServer

displays the Task List for Project page for this project.

3. If you entered the WorldServer URL in your browser, WorldServer displays its Home

page.

a. Click the Assignments tab, and then click Projects.

WorldServer displays its Projects page.

b. Click the name of the project whose WorldServer return package you want to

import.

Returning Completed Work to WorldServer
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WorldServer displays the Task List for Project page for that project.

4. Click Import...

WorldServer displays the Import Offline Work page.

5. Click Browse.

6. Navigate to and select the WorldServer return package file.

7. If you are authorized to update the WorldServer translation memory, you will see the

Update the translation memory using imported assets checkbox. If so, and you

want to update the WorldServer TM, select this checkbox.

8. Click Import.

WorldServer confirms that you claimed the task(s) whose files you are importing, and

that the files are locked in your name. It then imports the target file(s) and, if

appropriate, updates translation memory.

9. To complete the assigned workflow tasks whose files you imported so that

WorldServer can move them to the next step in their workflow, select the tasks and

click Complete...

WorldServer displays the Complete Task(s) page.

10. The Next Step field lists each available path in the workflow. Select the appropriate

next step, enter a comment that WorldServer presents to the next person assigned a

workflow step in this task, and click OK.

If you are assigned the next human step in the workflow, the tasks remain on this

Task List for Project page, and the step name changes to identify the new step.

Otherwise, WorldServer removes the tasks from this page because they are no longer

available to you.

Returning Completed Work to WorldServer
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Chapter 5

External Review Documents
The Bilingual DOCX import/export format lets reviewers evaluate assets outside of

WorldServer or SDLTrados Studio. The external review documents provide limited access

to target translation segments processed by a Studio file type.

The external review document kit consists of one or more DOCX files. You export and

import the Bilingual DOCX file either from the WorldServer Explorer, or as part of a

project. You can export any type of asset as a bilingual DOCX file for external review,

and then import assets from that file back into WorldServer after the review.

The following workflow gives another example of how you can use WorldServer and

Studio to work with an external reviewer.

Adding Studio to the translation and review workflow gives you several options.

■ Reviewers can return their DOCX changes to Studio translators, who have access

to track changes markup.

■ You could also choose to export a WXSZ project package fromWorldServer, and

then export and import the external review file from Studio.

Notes on the Bilingual DOCX Format
The project package that WorldServer provides for external review consists of one or more

DOCX files. The files consist of the assets segmented by Studio file types.

If the WorldServer administrator has specified the bilingual DOCX format as one of your

system options, you can create a DOCX file for your reviewers in one of two ways. See

other WorldServer online help topics for more information on importing and exporting

assets.
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WorldServer Explorer

Select the source folders or assets to export and select Tools > Export/

Import > Export Translation Kit from the WorldServer Explorer menu

bar. The bilingual DOCX format will be one of the export and import options.

Workflow Automatic Actions

Use export and import AAs inside a workflow to specify the bilingual DOCX format

for a translation kit. When you run the workflow, the review file will be produced at the

appropriate step. When your reviewers are done, you provide the file back to

WorldServer to pick up in the import step.

Export

When you plan to export assets for external review in a DOCX format, note the following.

■ For assets originally in DOCX format, use the track changes setting option for the

Microsoft Word 2007-2010 Studio File Type in WorldServer. This lets you see

tracked changes in Studio when you work with the translated asset.

Note: See the SDL Trados Studio online help for more information on using

Studio when you work with external review files for regulated industries.

■ The export process creates a bilingual DOCX file whose filename consists of the

WorldServer folder name and a long numerical “fingerprint” to identify it.

■ The only export option available is Segments to Exclude, which means that
the file won't include segments for which there are ICE or 100% matches in the
translation memory. See the WorldServer online help for more information.

■ New properties in the exchange.properties file govern the style of the

exported file. See the appendix to theWorldServer Administrator Guide for details.

Note: You can only export assets to this format if they were segmented by Studio file

types. If you try to export a legacy asset, WorldServer displays an error message and the

export aborts.

External Review Documents
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Import

When you import assets back into WorldServer from a bilingual DOCX file, note the

following.

■ The filename must be the same as when you exported it (as for all translation

kits).

■ The import will only change the existing target translations for the assets.

■ A second import of the same file will be ignored and have no effect on the assets.

■ Sub-segment comments are elevated to the segment level comments upon import,

just as for any Studio kit import.

■ The status of updated segments will be changed to No Status.

■ If segments with track changes are saved in translation memory, the

REVISIONMARKER placeholders and deleted strings are removed. In other

words, the TM segment is stored as if all track changes are accepted.

■ If some segments contain track changes, and if the original asset format is DOCX,

the target asset contains track changes. For any other asset format, track changes

may result in illegible text.

How to Review Bilingual DOCX Files
Reviewers without access toWorldServer or SDLTrados Studio can open bilingual DOCX

files in Microsoft Word, and edit the translation target segments as needed. Translators

using Studio can then pick up the review changes and integrate them back into a

WorldServer project package.

Review in Word

When you review a bilingual DOCX file in Word, note the following:

■ You may only change the existing target translation for any segment. Other

changes (including adding anything to blank target translations) are ignored on

import.

■ The review file will have the specific formats and colors that the WorldServer

administrator can change.

■ You can only export .DOCX files segmented with the Microsoft Word 2007-2013

Studio File Type in a Regulator Bundle review package. This feature does not

support Microsoft Word 2003 (or earlier) files, even if created with the Microsoft

Office Compatibility Pack installed. Reviewers have to use Microsoft Word

2007 or higher.

External Review Documents
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Note: For any asset format besides DOCX, imported track changes may result in illegible

text.

Review and Translate in Studio

When you use Studio to work with bilingual DOCX files, you have the full range of

Studio translation tools available. In Studio, you can easily identify placeholders that

represent tracked changes. Track changes updates segments as Deleted and Inserted

strings, enclosed in the following placeholders:

■ <SDL:REVISIONMARKER – Delete>, </SDL:REVISIONMARKER – Delete>

■ <SDL:REVISIONMARKER – Insert>, </SDL:REVISIONMARKER – Insert>

In Studio, you can also compare reviewer comments against translation memory and the

rest of the assets in the project package, before creating the WorldServer return package.

Note: If you open an an asset with tracked changes in the WorldServer Browser

Workbench, you will not be able to distinguish between placeholders that represent tracked

changes, and those that represent formatting.

External Review Documents
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Chapter 6

WorldServer Administrator
Information

This appendix contains configuration or other information for SDLWorldServer

administrators that may affect work for SDLTrados Studio project managers or translators

/reviewers.

Segment Status Default Change
In releases after SDLWorldServer version 9.4, the set_translation_statuses default (in the

tm.properties file) has been changed from False to True. SDL Trados Studio us
ers may notice the following affects on segment status:

■ Segments translated with ICE matches will be marked as “Reviewed” in

WorldServer, which corresponds to an “Approved” segment status in Studio.

■ 100% matches will be marked as “Pending Review” in WorldServer which

correspond to a “Translated” segment status in Studio.

These status changes allow Studio to more accurately reflect your translated leverage.

The default setting change affects assets segmented by both legacy and FTS filters.

WorldServer customers who are running in Live TM mode will not be affected, as this

setting is implicitly True for Live TM mode.

Without enabling this setting, segments won't reflect that they are context matches until

they are moved out of “Draft” status.

Note:WorldServer administrators can edit the tm.properties file to achieve the

same status and leverage in WorldServer 9.2 and 9.3. See the WorldServer Translation

Memory Mode Concepts Guide. If you plan to keep your own version of the

tm.properties file when you install WorldServer 9.4, we recommend that you

change this setting to obtain the listed benefits.
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Chapter 7

Studio User Notes
SDL Trados Studio has its own, very complete, set of user documentation. The following

notes describes aspects of WorldServer of particular interest to Studio users.

Starting with WorldServer 2011, version 10.1, WorldServer integration with Studio

includes the following areas:

■ Relaxed tag parity

■ WorldServer translation plug-in

Please see the SDL Trados Studio documentation for complete descriptions of Studio

features.

Relaxed Tag Parity
Starting with SDL Trados Studio 2011 and SDLWorldServer 2011 (release 10.2.1), the

default WorldServer environment (using Studio file types and Studio-aligned translation

memory mode) relaxes the requirement for tag parity in translation unit (TU) segments.

That is, some tags may be present in the translation target without a requirement that

they be in the translation source, or vice versa.

Studio 2011 and later create return packages for WorldServer 10.2.1 without enforcing

tag parity. Things to note:

■ Translation units which have tags that are out of parity are excluded from

WorldServer in-context exact (ICE) matches.

■ WorldServer resolves target-only tags through an automatic mechanism in the

associated WorldServer filter configuration for the file type, in general. If the

configuration does not use a Studio file type, or has another issue, leverage

penalties will be applied.
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Note: If you work in WorldServer's Browser Workbench, you may notice temporary

non-sequential placeholder ID numbering for non-parity segments brought in from

translation memory. The ID sequence generally resolves once a server round trip takes

place for the segment (such as when you save an asset, or add a segment comment), if not

before.

Legacy tag parity behaviors/settings

When you create a return package for a WorldServer version before 10.1, Studio 2014

and higher versions check for tag parity, the previous default behavior. The return package

creation will fail in Studio if tag differences exist in that case. Importing an out-of-parity

return package into pre-10.1 WorldServer environments will also fail.

If you do not want to verify tag parity in source and target translation units, configure the

Tag Verifier settings under File > Options > Verification > Tag

Verifier > Common.

WorldServer Translation Plug-in for Studio
Starting with SDL Trados Studio 2014, the translation memory (TM) attached to a

WorldServer package is centrally shared between WorldServer and Studio. When opening

a WorldServer package, Studio users with access to the WorldServer system also have

real-time access to the server-based TM attached to the package. This means that they

always see the most up-to-date version of the TM and can update it in real-time, while

confirming the translations in Studio.

The translation plug-in has the following limitations:

■ The default WorldServer scoping mode is always used for scoring purposes.

■ Not all penalties or penalty values are currently applied or displayed correctly,

since WorldServer penalties need to be mapped to penalties understood by Studio,

and there is no 1:1 correspondence.

■ For a concordance search, WorldServer's scoring rules are applied, which differ

from Studio's rules. (WorldServer's Studio-aligned TM mode only applies to

standard leverage scoring, not to concordance scoring.)

Note: For Studio 2011 and for packages created in earlier WorldServer versions, Studio

users only have access to the offline version of the TM. This is the version of the TM that

was available when the WorldServer project was created. For more information on the

plug-in, see the Studio documentation. If you are curious about how WorldServer handles

translation memory in general, you can find more information on WorldServer's

Studio-aligned TM mode in WorldServer Translation Memory Mode Concepts Guide.

Studio User Notes
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SDLWorldServer includes open source or similar third-party software.

JasperReports Server

JasperReports Server is a stand-alone and embeddable reporting server. It provides

reporting and analytics that can be embedded into a web or mobile application as well

as operate as a central information hub for the enterprise by delivering mission critical

information on a real-time or scheduled basis to the browser, mobile device, printer, or

email inbox in a variety of file formats. JasperReports Server is optimized to share,

secure, and centrally manage your Jaspersoft reports and analytic views.

Studio User Notes
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